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Appendix C: MATLAB’s
Simulink Tutorial

C.1 Introduction

Readers who are studying MATLAB may want to explore the functionality and
convenience of MATLAB’s Simulink. Before proceeding, the reader should have
studied Appendix B, the MATLAB Tutorial, including Section B.1, which is
applicable to this appendix.

MATLAB’s Simulink Version 7.4(R2009b) and MATLAB Version 7.9(R2009b)
are required in order to use Simulink.

The models described in this appendix, which are available at www.wiley.com/
college/nise, were developed on a PC using MATLAB Version 7.9 and Simulink
Version 7.4. The code will also run on workstations that support MATLAB. Consult
the MATLAB Installation Guide for your platform for minimum system hardware
requirements.

Simulink is used to simulate systems. It uses a graphical user interface (GUI)
for you to interact with blocks that represent subsystems. You can position the
blocks, resize the blocks, label the blocks, specify block parameters, and interconnect
blocks to form complete systems from which simulations can be run.

Simulink has block libraries from which subsystems, sources (that is, function
generators), and sinks (that is, scopes) can be copied. Subsystem blocks are available
for representing linear, nonlinear, and discrete systems. LTI objects can be generated
if the Control System Toolbox is installed.

Help is available on the menu bar of the MATLAB Window. Under Help
select Product Help. When the help screen is available, choose Simulink under the
Contents tab. Help is also available for each block in the block library and is accessed
either by right-clicking a block’s icon in the Simulink Library Browser and selecting
Help for . . . or by double-clicking the block’s icon and then clicking the Help
button. Finally, screen tips are available for some toolbar buttons. Let your mouse’s
pointer rest on the button for a few seconds to see the explanation.

C.2 Using Simulink

The following summarize the steps to take to use Simulink. Section C.3 will present
four examples that demonstrate and clarify these steps.

837

www.wiley.com/college/nise
www.wiley.com/college/nise


Apago PDF Enhancer

E1BAPP03 08/31/2010 18:54:20 Page 838

1. Access Simulink The Simulink Library Browser, from where we begin Simulink,
is accessed by typing simulink in the MATLABCommandWindow or by clicking
on the Simulink Library Browser button on the toolbar, shown circled in
Figure C.1.

In response, MATLAB displays the Simulink Library Browser shown in Figure
C.2(a). We now create an untitled window, Figure C.2(b), by clicking on the
Create a new model button (shown circled in Figure C.2(a)) on the tool bar of the
Simulink Library Browser. You will build your system in this window. Existing
models may be opened by clicking on the Open a model button on the Simulink
Library Browser toolbar. This button is immediately to the right of the Create a
new model button. Existing models may also be opened by selecting the Current
Folder from the command Window Start menu or the tab on the left side of the
CommandWindow as shown in Current Figure C.1, selecting your file names, and
then dragging them to the MATLAB Command Window.

2. Select blocks Figure C.2(a) shows the Simulink Library Browser from which all
blocks can be accessed. The left-hand side of the browser shows major libraries,
such as Simulink, as well as underlying block libraries, such as Continuous. The

FIGURE C.1 MATLAB Window showing how to access Simulink. The Simulink Library
Browser button is shown circled.
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right-hand side of Figure C.2(a) also shows the underlying block libraries. To
reveal a block library’s underlying blocks, select the block library on the left-hand
side or double-click the block library on the right-hand side. As an example, the
Continuous library blocks under the Simulink major library are shown exposed in
Figure C.3(a). Figures C.3(b) and C.3(c) show some of the Sources and Sinks
library blocks, respectively.

Another approach to revealing the Simulink block library is to type open_
system (‘simulink.mdl’) in the MATLAB CommandWindow. The window shown
in Figure C.4 is the result. Double-clicking any of the libraries in Figure C.4

FIGURE C.2 a. Simulink Library Browser window showing the Create a new model button
encircled b. resulting untitled model window
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FIGURE C.3 Simulink block libraries: a. Continuous systems b. Sources (figure continues)
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reveals an individual window containing that library’s blocks, equivalent to the
right-hand side of the Simulink Library Browser as shown in the examples of
Figure C.3.

3. Assemble and label subsystems Drag required subsystems (blocks) to your
model window from the browser, such as those shown in Figure C.3. Also,
you may access the blocks by double-clicking the libraries shown in Figure
C.4. You can position, resize, and rename the blocks. To position, drag with
the mouse; to resize, click on the subsystem and drag the handles; to rename, click
on the existing name, select the existing text, and type the new name. The text can
also be repositioned to the top of the block by holding the mouse down and
dragging the text.

4. Interconnect subsystems and label signals Position the pointer on the small arrow
on the side of a subsystem, press the mouse button, and drag the resulting cross-
hair pointer to the small arrow of the next subsystem. A line will be drawn
between the two subsystems. Blocks may also be interconnected by single-
clicking the first block followed by single-clicking the second block while holding
down the control key. You can move line segments by positioning the pointer on
the line, pressing the mouse button, and dragging the resulting four-arrow pointer.
Branches to line segments can be drawn by positioning the pointer where you
want to create a line segment, holding down the mouse’s right button, and
dragging the resulting cross hairs. A new line segment will form. Signals can
be labeled by double-clicking the line and typing into the resulting box. Finally,
labels can be placed anywhere by double-clicking and typing into the resulting box.

FIGURE C.3 (continued) c. Sinks
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5. Choose parameters for the subsystems Double-click a subsystem in your model
window and type in the desired parameters. Some explanations are provided in the
Parameters window. Press the Help button in the Parameters window for more
details. The parameters can be read later without opening the block. Let your
mouse’s pointer rest on the block for a few seconds, and a screen tip will appear,
identifying the block and listing its parameters. The information displayed in the
screen tip first must be selected in the Block Data Tips Options in the model
window’s View menu. Explore other options by right-clicking on a block.

6. Choose parameters for the simulation Select Configuration parameters . . . un-
der the Simulation menu in your model window to set additional parameters, such
as simulation time. Press the Help button in the Configuration parameters
window for more details.

7. Start the simulation Make your model window the active window. Double-click
the Scope block (typically, the scope is used to view the simulation results) to
display the Scope window. Select Start under the Simulation menu in your model
window or click on the Start simulation icon on the toolbar of your model window
as shown in Figure C.2(b). Clicking the Stop simulation icon will stop the
simulation before completion.

8. Interact with the plot In the Scope window, using the toolbar buttons, you can
zoom in and out, change axes ranges, save axis settings, and print the plot. Right-
clicking on the Scope window brings up other choices.

9. Save your model Saving your model, by choosing Save under the File menu,
creates a file with an .mdl extension, which is required.

C.3 Examples

This section will present four examples of the use of Simulink to simulate linear,
nonlinear, and digital systems. Examples will show the Simulink block diagrams as
well as explain the settings of parameters for the blocks. Finally, the results of the
simulations will be shown.

FIGURE C.4 Simulink Block
Library window
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Example C.1

Simulation of Linear Systems

Our first example develops a simulation of three linear systems to compare their
step responses. In particular, we solve Example 4.8 and reproduce the responses
shown in Figure 4.24. Figure C.5 shows a Simulink block diagram formed by
following Steps (1) through (5) in Section C.2 as follows:

Access Simulink; select, assemble, and label subsystems The source is a 1-volt
step input, obtained by dragging the Step block from the Simulink Library Browser
under Sources to your model window.

The first system, T1, consists of two blocks, Gain and Transfer Fcn. Gain is
obtained by dragging the Gain block from the Simulink Library Browser under
Math Operations to your model window. Transfer function, T1, is obtained by
dragging the Transfer Fcn block from the Simulink Library Browser under
Continuous to your model window. Systems T2 and T3 are created similarly.

The three output signals, C1, C2, and C3, are multiplexed for display into the
single input of a scope. The Mux (multiplexer) is obtained by dragging the Mux
block from the Simulink Library Browser under Signal Routing to your model
window.

The sink is a scope, obtained by dragging the Scope block from the Simulink
Library Browser under Sinks to your model window.

FIGURE C.5 Simulink block diagram for Example C.1
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Alternatively, all blocks can be dragged from the Library: simulink window
shown in Figure C.4. The Mux can be found under Signal Routing in the Library:
simulink window.

The labels for the blocks can be changed to those shown in Figure C.5 by
following Step (3) in Section C.2.

Interconnect subsystems and label signals Follow Step (4) to interconnect the
subsystems and label the signals. You must set the mux’s parameters before the
wiring can be completed. See the next paragraph.

Choose parameters for the subsystems Let us now set the parameters of each block
using Step (5). The Block Parameters window for each block is accessed by double-
clicking the block on your model window. Figure C.6 shows the Block Parameters
windows for the 1 volt step input, gain, transfer function 1, and mux. Set the
parameters to the required values as shown.

The scope requires further explanation. Double-clicking the Scope block in your
model window accesses the scope’s display, Figure C.7(a).

FIGURE C.6 Block parameters windows for a. 1 volt step source; (figure continues)
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FIGURE C.6 b. gain; c. transfer function 1; (figure continues)
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FIGURE C.6 (continued) d. mux

FIGURE C.7 Windows for the scope: a. Scope; b. ‘Scope’ parameters, General tab; (figure continues)
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Clicking the Parameters icon on the Scope window toolbar, shown in Figure C.7(a),
accesses the ‘Scope’ parameters window as shown in Figure C.7(b). The ‘Scope’
parameters window contains two tabs, General and Data history, as shown in
Figure C.7(b) and (c), respectively. Finally, right-clicking in the plotting area in the
Scope window and selecting Axis properties . . . reveals the ‘Scope’ properties:
axis 1 window, Figure C.7(d). We now can set the display parameters, such as
amplitude range.

Choose parameters for the simulation Follow Step (6) to set simulation parame-
ters. Figure C.8 shows the resulting Configuration Parameters window after

FIGURE C.7 (continued) c. ‘Scope’ parameters, Data history tab; d. ‘Scope’ properties: axis 1

FIGURE C.8 Simulation
Parameters window for Solver
tab
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selecting the Solver tab. Among other parameters, the simulation start and stop
times can be set.

Start the simulation Now run the simulation by following Step (7). Figure C.9 shows
the result in the Scope window. Plots are color coded in the order in which they
appear at the mux input as follows: yellow, magenta, cyan, red, green, and dark
blue. If the mux has more inputs, the colors recycle.

Interact with the plot The toolbar of the Scope window shown in Figure C.9 has
several buttons that can be used to interact with the plot. Let us summarize the
function and operation of each, starting with the left-most button:

Button 1 executes a plot print.
Button 2 has already been explained and is used to set scope parameters.
Button 3 permits zooming into the plot in both the x and y directions. Press the

button and drag a rectangle over the portion of the curve you want to
expand.

Button 4 allows zooming in the x direction only. Drag a horizontal line over the
plot covering the extent of x you want to expand.

Button 5 allows zooming in the y direction only. Drag a vertical line over the plot
covering the range of y you want to expand.

Button 6 autoscales axis for use after zooming.
Button 7 saves current axis settings.
Button 8 restores saved axis settings.

FIGURE C.9 Scope window after Example C.1 simulation stops
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Button 9 toggles floating scope. It must be turned off to use zooming. See
documentation for use of floating scopes.

Button 10 toggles lock for current axis selection.
Button 11 allows selection of signals to view when using floating scope.

Example C.2

Effect of Amplifier Saturation on Motor’s Load Angular Velocity

This example, which generated Figure 4.29 in the text, shows the use of Simulink to
simulate the effect of saturation nonlinearity on an open-loop system. Figure C.10
shows a Simulink block diagram formed by following Steps (1) through (5) in
Section C.2 above.

Saturation nonlinearity is an additional block that we have not used
before. Saturation is obtained by dragging to your model window the Satura-
tion block in the Simulink Library Browser window under Discontinuities as
shown in Figure C.11(a) and setting its parameters to those shown in Figure
C.11(b).

Now run the simulation by making your model window active and selecting
Start under the Simulation menu of your model window or clicking on the Start
simulation button on your model window toolbar. Figure C.12 shows the result in
the Scope window.

FIGURE C.10 Simulink block diagram for Example C.2

C.3 Examples 849



Apago PDF Enhancer

E1BAPP03 08/31/2010 18:54:31 Page 850

FIGURE C.11 a. Simulink library for nonlinearities; b. parameter settings for saturation
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Example C.3

Simulating Feedback Systems

Simulink can be used for the simulation of feedback systems. Figure C.13(a) is an
example of a feedback system with saturation.

In this example, we have added a feedback path (see Step (4) in Section C.2)
and a summing junction, which is obtained by dragging the Sum block from the
Simulink Library Browser, contained in the Math Operations library, to your
model window. The Function Block Parameters: Sum window, Figure C.13(b),
shows the parameter settings for the summer. You can set the shape as well as set
the plus and minus inputs. In the list of signs, the ‘‘|’’symbol signifies a space. We
place it at the beginning to start the signs at ‘‘nine o’clock,’’ conforming to our
standard symbol, rather than at ‘‘12 o’clock.’’ The result of the simulation is shown
in Figure C.14.

FIGURE C.12 Scope window after simulation of Example C.2 stops. The lower curve is the
output with saturation
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FIGURE C.13 a. Simulation block diagram for a feedback system with saturation; b. block
parameter window for the summer
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Example C.4

Simulating Digital Systems

This example demonstrates two methods of generating digital systems via Simulink
for the purpose of simulation, as shown in Figure C.15.

The first approach uses a linear transfer function cascaded with a Zero-Order
Hold block obtained from the Simulink Library Browser under the Discrete block
library, shown on the right-hand side of Figure C.16. The second method uses a
discrete transfer function also obtained from the Simulink Library Browser under
the Discrete block library. The remainder of the block diagram was obtained by
methods previously described.

The block parameters for the Zero-Order Hold and Discrete Transfer Fcn
blocks are set as shown in Figures C.17(a) and (b), respectively.

Select Configuration parameters . . . under the Simulation menu in your
model window and set the simulation stop time to 4 seconds, the type to fixed-
step, and the solver to ode4 (Runge-Kutta). The result of the simulation is shown in
Figure C.18.

FIGURE C.14 Simulation output for Example C.3
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FIGURE C.15 Simulink block diagram for simulating digital systems two ways

FIGURE C.16 Simulink library of discrete blocks
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FIGURE C.17 Function Block parameter windows for: a. Zero-Order Hold block; b. Discrete Transfer Fcn block
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Summary

This appendix explained Simulink, its advantages, and how to use it. Examples were
taken from Chapters 4, 5, and 13 and demonstrated the use of Simulink for
simulating linear, nonlinear, and digital systems.

The objective of this appendix was to familiarize you with the subject and get
you started using Simulink. There are many blocks, parameters, and preferences that
could not be covered in this short appendix. You are encouraged to explore and
expand your use of Simulinkby using the on-screen help that was explained earlier.
The references in the Bibliography of this appendix also provide an opportunity to
learn more about Simulink.

Output of continuous system with
zero-order hold

Output of sampled system

FIGURE C.18 Outputs of the digital systems
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